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Charities and Non-Profits (990)

Data entry on a tax-exempt organization (990) return is the same as data entry on the 
1040. Help, shortcut keys, and navigation through data entry all function as they do in 
the 1040. See 2012 Drake Software User’s Manual for the basics of using the pro-
gram. 

What’s New in Drake for Charities and Non-Profits

Drake programs its tax software according to the latest IRS rules and regulations. The 
2012 program reflects all IRS changes to credits and deductions, including discontinu-
ations. For specific details to the IRS’s changes, see the IRS instructions for individual 
forms for tax-exempt organizations.

The following section explains the main change to the 990 package for 2012.

Affiliate 
Listing 

for 
Extensions

If an extension must be filed for a 990 group return, a list of affiliates can now be 
attached to the return. To generate the affiliate listing:

1. Complete screen 8868 to produce Form 8868, Application for Extension of Time 
to File an Exempt Organization Return.

2. Open screen 1.

3. For question Ha - Is this a group return field for affiliates? mark the Yes box, 
and for question Hb - Are all affiliates included? mark the No box.

4. Open the SCH4 screen using the link on screen 1.

5. Complete the fields for the affiliates’ names, addresses, and EINs. Press PAGE 
DOWN for lists of nine or more.
Tax Year 2012 1
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Getting Started

Some early tasks you may need to perform when getting started on a 990 return 
include creating a return (for new clients) and updating a return (for existing clients).

Creating a Return

To create a new return in Drake:

1. From the Home window, click Open/Create (or select File > Open/Create 
Returns, or press CTRL+O).

2. In the Open/Create a New Return dialog box, enter the organization’s nine-digit 
identification number.

3. Click OK. Click Yes when asked if you want to create a new return.

4. In the New Return dialog box, select Tax Exempt - 990 and enter the organiza-
tion’s name.

5. Click OK.

Screen 1 of the return is displayed. You can now begin entering header information 
for the organization.

Updating a Prior-Year Return

If you prepared the organization’s tax return last year, you need to update it for 2012.

Prior-year returns can be updated in three ways:

• A single return (updated one at a time) using Last Year Data > Update Clients 
2011 to 2012 (recommended)

• When you open an existing prior-year return for the first time in the 2012 program 
and are prompted to update it

• With all other returns in the program using Last Year Data > Update Clients 
2011 to 2012 (not recommended)

Drake recommends using the first option (updating returns individually) to ensure that 
you update only those items in a return that you want updated.

NOTE
Blank forms are a good tool for helping clients collect tax-related data 
you will need. To access blank forms, go to Tools > Blank Forms and 
select the Tax-Exempt tab. Select a form from the list and click Print.

NOTE
Header information for all forms is completed on screen 1. For informa-
tion on specific fields in screen 1, see “Header Information (Forms 990, 
990-EZ, 990-PF, 990-T, 990-N)” on page 9.

NOTE
If you attempt to open a prior-year 990 return that was marked as “final” 
the previous year, the program informs you that the return was marked 
as final before it prompts you to proceed.
2 Tax Year 2012
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Schedule O

Use screen O to provide narrative information for Schedule O and for other schedules. 
Where in the return such information flows depends in part on which 990 type you’re 
working on, and in part on which item you select from the Schedule drop list on the O 
screen (see Figure 1).

In general, the leading letter of the selection from the Schedule drop list indicates 
where the information will go. For instance, a selection of A1 through A9 generally 
sends the information to Schedule A, and selections of C1 through C7 generally sends 
the information to Schedule C, and so forth.

Select Z1 through Z11, however, and the information flows to Schedule O of the 990-
EZ. Select X for general statements and the information flows to the Schedule O and 
the attachment will be e-filed with an e-fileable return (990, 990-EZ, or 990-PF). A 
selection of AMD (for an amended return) also sends the information to Schedule O 
of either a 990 or 990-EZ return.

See “Schedule O, Supp. Info.” on page 18 for more information.

Figure 1: A selection beginning with Z will flow to the Schedule O of the 990-EZ

Form 990-N

Form 990-N, Electronic Notice (e-Postcard) for Tax-Exempt Organizations Not 
Required to File Form 990 or 990-EZ, is required for certain small tax-exempt organi-
zations.

To file the e-Postcard using Drake, go to screen 1 for the organization and take the fol-
lowing steps:

1. Under the General Information heading, select N - Form 990-N from the Form 
drop list (item #1 in Figure 2 on page 4).

NOTE The SCH2 screen in a 990-PF return is the same as the O screen in the 
990 and 990-EZ returns.
Tax Year 2012 3
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Figure 2: Begin by selecting N - Form 990-N from the Form drop list on screen 1.

2. Under the EZ column (item #2 in Figure 2), mark item K to indicate that the orga-
nization’s gross receipts are normally not more than $50,000.

3. Go to the OFF screen and complete the Name and Title fields, enter an address 
(or select the Use entity address check box), and for at least one officer, select 
Principal officer.

Once any EF messages have been eliminated, the 990-N information can be e-filed. A 
“Form 990-N Information” page will be generated with the return for informational 
and bookkeeping purposes.

Form 990-EZ

Certain organizations can file Form 990-EZ, Short Form Return of Organization 
Exempt From Income Tax, instead of Form 990. If an organization’s gross receipts 
(total amounts received from all sources during its annual accounting period) are less 
than $200,000 and total assets at year-end are less than $500,000, it can file Form 990-
EZ instead.

Form 990-EZ Screens

The following screens are specifically provided for completing Form 990-EZ. They 
are grouped under the 990-EZ only heading of the Form 990/990EZ tab.

NOTE For information on signing a return prior to e-filing, see “Part II, Signa-
ture Block” on page 19.

Table 1: 990-EZ Screens Under Form 990/990EZ Tab

Screen Title/Section on Form 990-EZ

21 Part I, Revenue and Expenses
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Form 990-PF

Form 990-PF must be filed by certain exempt private foundations; see the IRS Form 
990-PF instructions for specific information on who must file this form.

Form 990-PF Screens

The 990-PF–specific screens are located under the Form 990PF tab (Figure 3).

Figure 3: Form 990PF tab in Drake (partial menu)

Several screens, such as screen 1, the DEPR, IND, and OFF screens, and certain 
schedule (SCH or SC) screens, can also be found elsewhere in the menu, as they 
apply for multiple forms and not just the 990-PF.

22 Parts II and III, Balance Sheet/Accomplishments

23 Part V, Other Information, Page 1

24 Part VI, Section 501(c)(3) Only

O Schedule O, Supplemental Information

SCH3 Other Items

SCH5 Part I, Line 5c

SC21 Unreported Activities

SC40 Part I, Grants and Similar Amounts Paid

SC42 Part II, Other Assets/Liabilities

Table 1: 990-EZ Screens Under Form 990/990EZ Tab

Screen Title/Section on Form 990-EZ

NOTE For information on signing a return prior to e-filing, see “Part II, Signa-
ture Block” on page 19.
Tax Year 2012 5
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Recommended Order for Completing Form 990-PF

The IRS recommends completing Form 990-PF in the following sequence to limit 
jumping from one part of the form to another.

Part I 
Additional 
Schedules

Additional schedules may be needed to complete the following lines from Part I (#2 in 
Table 2):

• Line 6a (Net gain or loss from sale of assets not on line 10) — Use screen SCH5.

• Line 10 (Gross profit or loss) — Use screen SCH7.

• Line 11 (Other income) — Use screen SC50 for subsidiary schedule.

• Line 18 (Taxes) — Use screen SC50.

• Line 19 (Depreciation) — Use screen DEPR for depreciation schedule. (The lines 
for Net Investment income and Adjusted net income on the DEPR screen are 
required for columns B and C of page 1 of Form 990-PF.)

Table 2: Form 990-PF, Recommended Order

Seq. Section Screens Notes

1 IV 55

2 I and II 52, 53, 54 For required schedules, see “Part I Addi-
tional Schedules” and “Part II Additional 
Schedules” (following).

3 Heading 1, 51

4 III SCH3

5 VII-A 57 Use screen SC57 to create a schedule for 
controlled entities.

6 VIII OFF Use the IND screen to enter data for inde-
pendent contractors.

7 IX-A through X 59 If an explanation is required for line 1e of 
Part X, use screen SC59, Reduction Expla-
nation.

8 XII, lines 1–4 60 Line 4 is calculated automatically in Drake.

9 V and VI 56

10 XII, lines 5–6 n/a Calculated automatically in Drake.

11 XI 60

12 XIII 61

13 VII-B 58

14 XIV – XVII 62–66

NOTE This information is also available from the FAQ screen, item K (“Rec-
ommended Order for Completing Form 990-PF”).
6 Tax Year 2012



Drake Software User’s Manual Supplement: Non-Profits Form 990-T
• Line 23 (Other expenses) — Use screen SC50 for subsidiary schedule; use screen 
DEPR for amortization schedule. (The lines for Net Investment income and 
Adjusted net income on the DEPR screen are required for columns B and C of 
page 1 of Form 990-PF).

Part II 
Additional 
Schedules

Additional schedules may be needed to complete the following lines from Part II (#2 
in Table 2 on page 6):

• Lines 6 (Receivables due from officers, directors...) — Use screen SC14.

• 7 (Other notes/loans receivable) — Use screen SC14 (This produces statement 
STM 135) and/or screen SCH3 (This produces statement STM 113).

• Lines 10a – 10c (Investments) — Use screen SC54.

• Lines 11 (Investments – land, buildings...) — Use screen SC53 for subsidiary 
schedule.

• Line 13 (Other investments) — Use screen SC53 for subsidiary schedule.

• Line 15 (Other assets) — Use screen SC53 for subsidiary schedule.

• Line 20 (Loans from officers, directors...) — Use screen SC55.

• Line 21 (Mortgages and other notes payable) — Use screen SC55.

• Line 22 (Other liabilities) — Use screen SC53 for subsidiary schedule.

Using 
Screen SCH2

Screen SCH2, Supplemental Information and General Explanation Attachment, 
allows you to attach explanations for certain parts of the Form 990-PF.

It is necessary to identify which part of the form is to be associated with the attached 
statement. To select a section of a form, choose an option from the Schedule drop list 
at the top of screen SCH2. Next, write an explanation in the Explanation field. Press 
PAGE DOWN as needed for additional attachments. Note that there is a 5,000-character 
limit for e-filing.

Form 990-T

Form 990-T, Exempt Organization Business Income Tax Return, is used for:

• Reporting unrelated business income and tax liability

• Reporting proxy tax liability

• Claiming a refund paid by either a regulated investment company (RIC) or a real 
estate investment trust (REIT) on undistributed long-term capital gain

• Requesting a credit for certain federal excise taxes that have been paid

• Claiming Form 8941 credit for small-employer health insurance premiums

NOTES
The SCH2 screen can be used for other 990 return types. Note that 
screens O (for Schedule O, Supplemental Information) and SCH2 are 
the same. See “Schedule O” on page 3 for more information.

If X (General explanation attachment) is selected from the Schedule 
drop list, the attachment will be e-filed with an e-fileable return (990, 
990-EZ, or 990-PF).
Tax Year 2012 7
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Based on the items listed above, an organization may need to complete Form 990-T in 
addition to its 990, 990-EZ, 990-PF, or 990-N return. See Form 990-T instructions to 
determine if an organization is required to file Form 990-T.

Form 990-T cannot be e-filed.

Form 990-T Screens

All 990-T–specific screens are located under the Form 990T tab.

Figure 4: Form 990T tab

Form 990

Form 990 must be filed by a tax-exempt organization under section 501(a) if it has 
either:

• Gross receipts of $1 million or more

• Total assets of $2.5 million or more at the end of the tax year

For more information on who must file Form 990, see the Form 990 instructions pub-
lished by the IRS.

Recommended Order for Completing Form 990

The sequence shown in Table 3 on page 9 is suggested as an efficient method for com-
pleting a return for a tax-exempt organization. In general, complete the core form first, 
and then complete—alphabetically—Schedules A through O and Schedule R, except 
as specified in Table 3 on page 9. This order limits the need to jump back and forth 

NOTE
Screen 80 must include a selection for item G (organization type) in 
order for Form 990-T to be produced correctly, with the appropriate tax 
calculated.
8 Tax Year 2012



Drake Software User’s Manual Supplement: Non-Profits Form 990
from one part of the form to another, as certain later parts are required in order to com-
plete earlier parts.

Header Information (Forms 990, 990-EZ, 990-PF, 990-T, 990-N)

Use screen 1 to fill out the header section for a tax-exempt organization. Complete all 
applicable fields. Enter the organization’s ID number, name, address, and telephone 
number at the top of screen 1.

Table 3: Form 990, Recommended Order

Seq. Section Screens Notes

1 A – F; H(a) – M 
(heading)

1 This is the “Heading” section of Form 
990; line M is completed automatically 
based on resident state entered.

2 Schedule R R, R2, R3 Determine related organizations, disre-
garded entities, and joint ventures for 
which reporting will be required. (See 
Sch. R instructions; Form 990 instruc-
tions, Appendix F, Disregarded Entities 
and Joint Ventures).

3 Part VII, Section A OFF

4 Part VIII, IX, and X 8, 9, and 10

5 Header line G 1 Completed automatically in Drake

6 Parts III, V, VII, and 
XI

3, 4, 6, IND, 11

7 Schedule L L Complete if required; see Schedule L 
instructions.

8 VI 7 Transactions reported on Schedule L 
are relevant to determine independence 
of members of the governing body under 
Form 990, Part VI, line 1b.

9 I 2 Complete based on information derived 
from other parts of the form.

10 IV 5 Complete this section to determine 
which schedules must be completed.

11 Schedule O and 
any other applica-
ble schedules

Schedules A – 
G and Sched-
ules H – R tabs

12 II PIN; Setup info See “Part II, Signature Block” on 
page 19.

NOTE
Header information to be completed first are items A through F and 
H(a) through M. The Gross receipts field (header item G on the 990) is 
completed automatically.
Tax Year 2012 9



Form 990 Drake Software User’s Manual Supplement: Non-Profits
Foreign 
Address

If the organization has a foreign address, fill out the applicable fields in the Foreign 
ONLY section of screen 1.

Type of Form To indicate which form the organization is filing, select an option from the Form drop 
list on screen 1. (See Figure 2 on page 4 and Figure 5, below.) If the only return being 
prepared is a 990-T and its related forms, mark the 990-T only box.

Form 
Columns

Screen 1 has separate columns indicating the header boxes for Forms 990, 990-EZ, 
and 990-PF. For example, the “Exemption application pending” check box on screen 1 
(item #1 in Figure 5) puts an “X”  in box B of Forms 990 and 990-EZ, or an “X” in 
box C of Form 990-PF. Note that not all questions are required for all forms (item #2 
in Figure 5).

Figure 5: Screen 1 shows header labels for different forms (1);
not all questions are required for all forms (2).

Affiliate 
Listing 

(990 Only)

If the 990 is a group return filed for affiliates, but not all affiliates are included, a list 
of affiliates must be attached to the return. Screen SCH4 is available for this purpose 
and includes fields for affiliate name, address, and EIN. Click the SCH4 link on 
screen 1 (Figure 5). 

Tax Year The program uses the current calendar tax year (beginning January 1 and ending 
December 31) by default. If the organization uses a fiscal year, enter the beginning 
and end dates in the If not calendar year box on screen 1 (Figure 6).

Figure 6: If not calendar year box on screen 1

NOTE
The default data for the Name Control field on screen SCH4 is the 
four-letter code used by the IRS to match the information to the affiliate. 
This is an override field and must be completed if the name of the affili-
ate has changed since the entity’s last filed return.
10 Tax Year 2012



Drake Software User’s Manual Supplement: Non-Profits Form 990
Schedule R

Once you have completed the header information on screen 1, the IRS recommends 
completing Schedule R, Related Organizations and Unrelated Partnership. Schedule R 
is used to submit data regarding the organization’s relationships with other organiza-
tions, both taxable and tax-exempt. The program has three screens for Schedule R, 
listed in Table 4.

To enter more entities, press PAGE DOWN to access new, blank fields.

Part VII, Section A

Once you have completed Schedule R, the IRS recommends completing Part VII, Sec-
tion A (“Compensation of Officers, Directors, Trustees, Key Employees, Highest 
Compensated Employees, and Independent Contractors”). Use the OFF screen to 
report this information, noting that information entered there is used to generate Part II 
of Schedule J (“Compensation Information”).

Parts VIII, IX, and X

Parts VIII, IX, and X of Form 990 comprise the financial statements for tax reporting 
purposes. These sections are accessed from screens 8, 9A, 9B, 10A, and 10B of the 
program.

Statement of 
Revenue

The program has two screens for Part VIII, Statement of Revenue. Go to screen 8 to 
complete items 1 and 3 through 10. Press PAGE DOWN (or click the Lines 2 11 screen 
hyperlink) to access fields for items 2 (“Program Service Revenue”) and 11 (“Miscel-
laneous Revenue”).

Table 4: Schedule R Screens

Screen Sections of Schedule R Covered

R Schedule R, Parts I (Disregarded Entities), II (Related Tax-Exempt Organiza-
tions), and III (Related Organizations Taxable as a Partnership)

R2 Schedule R, Parts IV (Related Organizations Taxable as a Corporation or 
Trust), V (Transactions With Related Organizations), and VI (Unrelated Orga-
nizations Taxable as a Partnership)

R3 Schedule R, Part V, Line 1

NOTE
Schedule R is not required for all organizations. For information on 
which aspects of Schedule R must be completed by an organization, 
see the IRS instructions for Schedule R. See also screen-level help in 
Drake for screens R, R2, and R3.

NOTE
Use the IND screen to enter information about compensation of inde-
pendent contractors. See “Compensation” on page 14 for more infor-
mation on the IND screen. 
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Statement of 
Functional 
Expenses

Use the organization’s normal accounting method to complete Part IX, Statement of 
Functional Expenses. Part IX should not be used to report expenses that belong on 
lines 6b, 7b, 8b, 9b, or 10b of Part VIII, Statement of Revenue.

Part IX has two screens; to access the first screen (lines 1 though 14), go to screen 9A. 
To access the second screen (lines 15 through 26), go to screen 9B (or press PAGE 
DOWN from screen 9A).

Balance 
Sheet

All organizations must complete Part X. A substitute balance sheet cannot be used.

Part X has two screens; to access the first screen (lines 1 through 15), go to screen 
10A. To access the second screen (lines 17 through 32), go to screen 10B (or press 
PAGE DOWN from screen 10A).

Header Line G

The program calculates header line G (gross receipts) automatically based on the 
information entered in on screen 8, (including the linked Line 2 11 Screen). 

Parts III, V, VII, and XI

Once you have completed Box G of the header, the IRS recommends completing Parts 
III, V, VII, and XI of Form 990 (screens 3, 4, 6, IND, and 11).

Purpose & 
Achievement

Part III, Statement of Program Service Accomplishments, requires that the organiza-
tion report its new, ongoing, and discontinued exempt purpose achievements, along 
with any related revenue and expenses.

In Drake, Part III of Form 990 consists of two screens. Use screen 3 to answer items 1 
through 3 (exempt purpose). Use screen 4 to complete the line 4 items (exempt pur-
pose achievements). From screen 3, you can access screen 4 by pressing PAGE DOWN.

Exempt 
Purpose

Use the Primary exempt purpose field on screen 3 to describe the organization’s 
mission. The mission statement can address why the organization exists, what it hopes 
to accomplish, whom it intends to serve, and activities it will undertake and where. 
See IRS instructions for further information on what constitutes a mission.

NOTES
Screen Help in the program provides further instructions on this section. 
To access Screen Help, click the Screen Help button on the upper right 
corner. (You can also access Screen Help by right-clicking the screen 
and choosing Screen Help from the right-click menu, or by pressing 
CTRL+ALT+? from the 9A or 9B screens).

For additional information, see the IRS instructions.

NOTE
Some end-of-year amounts require separate schedules. Screens for 
these schedules can be accessed by clicking the applicable links on 
screens 9A, 9B, 10A, 10B, and 11.

NOTE If the organization does not have a mission that has been adopted by 
its governing body, type None as the Primary exempt purpose.
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If you answer Yes to question 2 or 3 on screen 3, use Schedule O (screen O) to 
describe any new services or changes to services. From screen 3, you can click the 
Sch O Screen hyperlink to access this screen. See “Schedule O, Supp. Info.” on 
page 18 for more information about filling out Schedule O in the program.

Exempt 
Achievement

Enter expenses, revenue, and a description of the exempt purpose achievements on 
screen 4. Examples of exempt achievements include:

• Providing charity care under a hospital’s charity care policy

• Providing higher education to students under a college’s degree program (the 
number of students served must be indicated)

• Making grants or providing assistance to individuals who were victims of a natu-
ral disaster

• Providing rehabilitation services to residents of a long-term care facility

Acceptable exempt achievements do not include any achievement not substantially 
related to the accomplishment of the organization’s exempt purpose (other than by 
raising funds).

To enter a description that exceeds the allowed number of characters on screen 4, 
press PAGE DOWN and continue the description. There is no need to re-enter the infor-
mation in the top section of the screen. If the description takes up more space than is 
allowed on the printed return, the program will generate it on a separate SERVICES 
page. (See Figure 7.)

Figure 7: Part III of Form 990 references a SERVICES page for descriptions
that are too long to be printed on the actual 990 form.

To enter another achievement, press PAGE DOWN and mark the box labeled Check 
this box if starting a new description. The second description entered is shown (or 
referenced on a SERVICES page, if applicable; see Figure 7) in section 4b of Part III. 
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A third description is printed or referenced in section 4c. Additional descriptions are 
shown on a SERVICES page generated with the return.

Other IRS 
Filings

Part V, Statements Regarding Other IRS Filings and Tax Compliance, is used to show 
the organization’s compliance with the requirements of other federal tax laws for 
reporting and substantiation. Use screen 6 in the program to enter data for Part V. In 
Drake, Part V consists of two screens: use screen 6 to answer items 1 through 6b; 
press PAGE DOWN from screen 6 to access items 7 through 14b.

Compen-
sation

Part VII reports compensation paid to officers, directors, trustees, key employees, 
highest-compensated employees, and independent contractors. For Form 990, 990-EZ, 
or 990-PF, use the OFF screen (for officers, etc.) and the IND screen (for independent 
contractors) to enter this information.

The OFF screen also has fields for entering an officer address, “books in care of” 
information, and an indication of whether the specified officer signs the return. The 
IND screen has fields for name and address, type of service, and compensation, and a 
field to enter the number of contractors paid more than $100,000 ($50,000 for 990-PF) 
in reportable compensation.

Reconcili-
ation of Net 

Assets

Enter the amount of other changes in net assets or fund balances that occurred during 
the tax year on the first line of screen 11. These would include items such as prior-
period adjustments and changes in accruals.

Explain the changes on screen O, selecting code O26 in the Schedule drop list.

Financial 
Statements 

& Reporting

Part XII, Financial Statements and Reporting, is used for reporting information on the 
organization’s accounting methods and financial statements. The accounting method 
(line 1 of Part XII) is pulled from the method indicated on screen 1. Use screen 11 to 
answer all other items for Part XII.

Schedule L, Transactions With Interested Persons

Screen L contains fields for completing Parts I through IV of Schedule L, Transac-
tions With Interested Persons. All or part of Schedule L may be required for certain 
organizations that file Forms 990 or 990-EZ. Schedule L is used for the following pur-
poses:

• Reporting information on certain financial transactions or arrangements between 
the organization and disqualified persons under section 4958 or other interested 
persons

• Determining whether a member of an organization’s governing body is an inde-
pendent member for purposes of Form 990, Part VI, line 1b (“Enter the number of 
voting members who are independent”)

For information on which organizations must complete all or part of Schedule L, see 
the screen L screen help in the program, or consult the IRS instructions.

NOTE
The exempt achievement description has a 5,000–character limit for 
e-filing; if the description exceeds 5,000 characters, the return must be 
paper-filed.
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Part VI, Governance, Management, and Disclosure

Part VI, Governance, Management, and Disclosure, requests information regarding 
the governing body and management governance policies and disclosure practices. 
Although federal tax law generally does not mandate particular management struc-
tures, operational policies, or administrative practices, every organization is required 
to answer each question in Part VI.

Use screen 7 to access fields for Section A of Part VI. Press PAGE DOWN to access 
Sections B and C. If additional information is required for Part VI, use Schedule O 
(screen O; see “Schedule O, Supp. Info.” on page 18).

Part I, Summary

The summary section asks for information regarding the mission, activities, and finan-
cial results of the organization. Use screen 2 to complete Form 990 Part I, Summary.

Number of 
Volunteers

Enter the number of full-time and part-time volunteers who provided volunteer ser-
vices to the organization during the reporting year. A reasonable estimate is acceptable 
if an exact number is not known. If the organization wishes to provide an explanation 
of how the number was determined, use Schedule O (screen O in the program; see 
“Schedule O, Supp. Info.” on page 18).

Line 7b If the organization is not required to file Form 990-T, enter a zero (0) for line 7b.

Lines 8–17 Prior-year amounts are updated automatically from the previous year’s return. These 
amounts can be entered or edited on screen 2.

Part IV, Checklist of Required Schedules

An organization uses Part IV, Checklist of Required Schedules, to determine which 
schedules must be completed and filed with the tax return. In Drake, two screens con-
tain fields for Part IV. Open screen 5 to access fields for lines 3 through 24d. Press 
PAGE DOWN from screen 5 to access fields for lines 25a through 37.

Schedules

Use the Schedules A – G and Schedules H – R tabs to access schedules. Click a 
schedule letter or title to open the screen for that schedule. Specific schedules can also 
be accessed using hyperlinks within screens. (Figure 8 on page 16)
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Figure 8: Screen 5 links to schedules

Schedule A Use Schedule A, Public Charity Status and Public Support, with Form 990 or Form 
990-EZ to provide information regarding public charity status and public support.

Use the following screens to enter data for Schedule A:

• Screen A (Part I, Reason for Public Charity Status; required by all organizations 
filling out Schedule A.)

• Screen A2 (Part I, Line 11, Information about Supported Organizations)

• Screen A3 (Parts II and III, Support Schedules)

Schedule B, 
Contributors 

Use Schedule B, Schedule of Contributors, with Form 990, Form 990-EZ, or Form 
990-PF to provide information on certain contributions reported by the organization. 
Schedule B is required for contributions from at least one contributor in excess of 
$5,000. If there are no entries for the required Schedule B fields in the program, an EF 
message is generated and the return cannot be e-filed. In Drake, use screen B to enter 
Schedule B information.

Schedule C, 
Political & 
Lobbying

Schedule C is required for certain section 501(c) organizations and section 527 orga-
nizations filing Form 990 or Form 990-EZ. Use the following screens for Schedule C:

NOTE
Some longer schedules require more than one screen to complete. For 
example, Schedule A consists of screens A, A2, and A3. You can 
access screens A2 and A3 from the Schedule tab, or you can press 
PAGE DOWN from screen A to access subsequent screens.

NOTES

Schedule A is required. At a minimum, amounts must be entered for the 
current year—even if the amounts are zero. If there are no entries for 
Schedule A, an EF message is generated upon calculation, and the 
return cannot be e-filed.

Field- and screen-level help resources within the program provide valu-
able supplemental information and tips for completing Schedule A in 
Drake. Press F1 for field-level help. On screens A and A3, click  
Screen Help for screen-level help.

NOTES
Contributor information on Schedule B is not publicly disclosed.

If Schedule B is not required, mark the check box on the lower-right 
side of screen 1.
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• Screen C — Parts I-A, I-B, and I-C

• Screen C1 — Part I-C, line 5 (names, addresses, and EINs of 527 organizations to 
which payments were made)

• Screen C2 — Parts II-A and II-B

• Screen C3 — Parts III-A and III-B

See the IRS form instructions for who is required to file.

Schedule D, 
Financial 

Statements

Filers of Form 990 should use Schedule D to provide the required reporting for the 
categories listed in Table 5. Table 5 also shows which screens in Drake are available 
for completing specific information.

Press PAGE DOWN to go to the next Schedule D screen.

To enter data for Parts VII through X, go to screen D4 and select the applicable part 
from the Part drop list (Figure 9).

Figure 9: Select the applicable part on screen D4 For parts VII through X.

Table 5: Schedule D: Items Covered, and Screens Used

Category
Section of 

Schedule D
Screen to Use 

in Drake

Donor-advised funds (DAFs) Part I D

Conservation easements Part II D

Certain art and museum collections Part III D2

Escrow accounts and custodial arrangements Part IV D2

Endowment funds Part V D3

Investments - Land, Buildings, Equipment Part VI D3

Investments - Land, Buildings, Equipment Part VI, line 1e 
(“Other”)

D1E

Supplemental financial information Parts VII through X D4

Supplemental financial statements Parts XI through XII D5

NOTE
Note that Part VI, line 1e (“Other”) requires a separate screen from the 
previous Part VI information. Click the Line 1e detail link on screen D3 
or open screen D1E.
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Press PAGE DOWN to access a blank D4 screen and enter data for additional parts.

For information on completing Part XIII of Schedule D, see the “Schedule O, Supp. 
Info.” section, following.

Schedule O, 
Supp. Info.

The IRS provides Schedule O for filers who must include narrative information for 
specific lines. Use screen O to provide narrative information for Schedule O and for 
other schedules.

To use screen O:

1. Open the screen (available through the Form 990/990EZ tab, the Schedule H - R 
tab, a link on the D4 screen, or–as the SCH2 screen–from the Form 990PF tab.

2. From the Schedule drop list, select the schedule and line numbers to be addressed 
on the screen. In the example on Figure 10, the user has selected Escrow Account 
Liability in order to address Part IV, line 2b of Schedule D. 

Figure 10: Schedule drop list on screen O

3. Under Explanation, type the narrative information. Note that there is a 5,000-
character limit for e-filing.

Press PAGE DOWN to open a blank screen O and add supplemental information for 
another schedule or line.

Data entered on screen O is printed in the supplemental information section of the 
specified schedule. For example, the narrative from Figure 10 would be printed under 
Schedule D, Part XIII, “Supplemental Information.”

NOTE Screen O allows you to enter narrative information for numerous sched-
ules—not just for Schedule O.

NOTES
The codes for the O screen are preceded by the letter O.

To add a narrative explanation for an amended return, select AMD 
(located just before the O items in the drop list). See “Amending a 
Return” on page 20 for more on amending a return.

To add a general explanation attachment, select X (located at the bot-
tom of the drop list).
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Part II, Signature Block

The signature block on Form 990 contains fields for up to two signatures:

• An officer of the organization

• The paid preparer (if applicable)

If e-filing, enter the paid preparer and organization officer PINs on the PIN screen.

Note about 
Preparer ID 

Generally, anyone who is paid to prepare a return must sign the return and fill in the 
other blanks in the “Paid Preparer’s Use Only” area of the return. An employee of a 
filing organization is not a paid preparer.

In order to have the preparer ID number (PTIN or SSN) printed in the applicable space 
on the return, the preparer must:

• Sign the return in the space provided for the preparer’s signature

• Enter the preparer information

• Give a copy of the return to the organization

Preparing 990 
returns in 

Drake

Any 990 returns (including 990-EZ, 990-PF, 990-N, and 990-T) prepared in Drake 
Software will have the preparer’s PTIN and the firm’s EIN printed in the “Paid Pre-
parer’s Use Only” section of the return automatically. The only return in which the 
preparer’s SSN will be printed in the “Paid Preparer’s Use Only” section is one that 
meets these conditions:

• The Section 4947(a)(1) check box on screen 1 is marked

• Line 12a of Part 5, (screen 6, press PAGE DOWN) is marked “Yes” (for 990 return)

• Line 43 of screen 23 is marked (for 990EZ return)

• Line 15 of screen 57 is marked (for 990PF return)

• There is no PTIN entered for the preparer in Setup > Preparer(s) or no PTIN 
entered on the PREP screen.

Filing an Extension

Calendar-year returns are due on May 15, 2013. If an organization uses a fiscal year, 
the return is due by the fifteenth day of the fifth month after the accounting period 
ends. By filing Form 8868, an organization can extend the deadline three months (to 

IMPORTANT
The applicable ERO or preparer PIN must be entered in Setup > 
Preparer(s) or Setup > Firm(s) in order to e-file a tax return. For 
more information on setting up firm, preparer, and ERO informa-
tion in Drake, see 2012 Drake Software User’s Manual.

IMPORTANT
The IRS is not authorized to redact (delete) the paid preparer’s 
SSN if the SSN is entered in the paid preparer’s block. Form 990 
is a publicly disclosable document. Any paid preparer whose ID 
number must be listed on Form 990 may wish to apply for and 
obtain a PTIN using Form W-7P. 
Tax Year 2012 19



Amending a Return Drake Software User’s Manual Supplement: Non-Profits
August 15 for a calendar year return). Form 8868 can be used to apply for an addi-
tional three-month extension if the original three-month extension was insufficient.

Use the 8868 screen (available from the Other Forms tab) to apply for an extension. 
Select the applicable box at the top of the 8868 screen to indicate the type of extension 
being requested.

Figure 11: Select the type of extension being requested.

If requesting an additional extension, an explanation is required on the 8868 screen.

Amending a Return

Indicate an amended return on screen 1. Note that an explanation is required for an 
amended return.

To provide an explanation for an amended return:

1. Open screen O.

2. From the Schedule drop list, select AMD - Amended Return Information. This 
selection is located between the N and O items in the Schedule drop list, as shown 
in Figure 12 on page 21.

NOTE Form 8868, Application for Additional Extension of Time to File an 
Exempt Organization return can be e-filed.

CAUTION
When you amend a return in Drake, the amended information 
replaces the original in the data file. Before amending a return, you 
should archive the original to avoid losing previously submitted data. 
For more information on archiving returns, see “Archive Manager” in 
Chapter 6 of the 2012 Drake Software User’s Manual.
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Figure 12: The AMD selection is listed between the N and O selections.

3. Enter the explanation in the text box below the drop list. Character limit for e-fil-
ing is 5,000 characters.

Binary Attachments

Binary, or PDF, files can be attached to certain tax forms. These attachments are gen-
erally signature or third-party documents such as a copy of a signed lease or a signed 
appraisal statement. In some instances, the IRS requires that a document be attached 
to an e-filed return; in other instances, a document can be attached voluntarily to sup-
port or explain an entry in the return. In either case, a document must be in PDF for-
mat and attached to the return in order to be e-filed with it. Paper documents must be 
scanned into the computer to be attached.

Attach files through the PDF Attachments screen, accessible from the Electronic 
Filing section on the General tab of the Data Entry Menu.

The PDF Attachment Process

Three main steps are involved in the PDF attachment process in Drake:

1. Creating a PDF file to be attached

2. Informing the program that a PDF file will be sent with the return

3. Attaching the PDF file for e-filing

These steps are described in the following sections.

Creating a 
PDF File

To create a PDF file:

1. Scan the document to be attached to the return. 

IMPORTANT The amended return should include all information pertaining to 
the return—not just the new or corrected data.

NOTE
This PDF–attachment feature is available in several packages in Drake. 
Some of the examples shown in this section are from other packages, 
but the feature works the same way in all packages.
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2. Save the document to your client’s DDM file, your computer’s desktop, or any-
where you can readily find it.

Adding PDF 
Files in 

Drake

To indicate in the software that a PDF file will be sent with the return:

1. Open the return in Drake. From the Form 990/990EZ tab of the Data Entry 
Menu, click PDF, or type PDF in the selector field and press ENTER.

2. Fill out the columns on the PDF Attachments screen. See Table 6 for examples.

3. Exit the PDF Attachments window.

Because you’ve indicated that a PDF file is attached, the program generates an EF 
message regarding the attachment when the return is calculated.

Attaching 
Documents 

to the Return 

To attach a PDF file to a return:

1. From the return, click View. If anything was entered in the PDF Attachments 
window (see “Adding PDF Files in Drake,” previously), there will be two PDF–
related items in the View/Print window:

• An EF MESSAGES alert (item #1 in Figure 13)

• An Attach PDF button on the toolbar (item #2 in Figure 13)

Figure 13: The red MESSAGES page and the Attach PDF button

TIP It’s a good idea to use the DDM scanning feature for this step.

Table 6: PDF Attachment Window Columns

Name of Column Description Examples

Reference Source Name or number of regulation, 
publication, or form instruction that 
makes attachments necessary

- IRS Pub xxx-1.4
- Form Instructions for 990

Description Description of form or document to 
be attached

- Title of house on Oak Street
- Appraisal of Lot 1234

File name Distinctive, easily recognizable file 
name, followed by “.pdf”

- TitleHouseOakSt.pdf
- AppraisalLot1234.pdf
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2. Click MESSAGES to view EF messages, including information on how to attach 
the required documents to the return.

3. Click Attach PDF. The EF PDF Attachments window displays the information 
entered on the PDF Attachments window in data entry. A red X means the docu-
ment has not been attached; a green check mark indicates an attached document.

Figure 14: The EF PDF Attachments window

4. Click the row of a document to attach.

5. Click Browse.

6. Browse to the proper folder, select the PDF file to attach, and click Open (or dou-
ble-click the file name).

Repeat for all documents with a red X. When all documents have been attached to a 
completed return, recalculate the return. If there are no EF messages, the return is 
ready to be e-filed.

Printing Generated Documents

In some instances, Drake generates a document that must be printed, signed, and 
scanned back into the computer to be attached to the return. An EF message will state 
that attachments are required. You will then need to obtain and complete the state-
ments, scan them into the computer, save them as a PDF file, and attach them to the 
return.

Using the PRNT Screen

Use the PRNT screen to override most program defaults.

Suppressing/Forcing Items

To suppress or force printing of certain items, go the PRNT screen and select the 
desired options.Selections override the options established in Setup. For more on set-
ting up options globally in Drake, see 2012 Drake Software User’s Manual.

The following items can be “forced” from the PRNT screen (see Figure 15 on 
page 24):
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• Diagnostic summary report listing the forms calculated and providing a brief sum-
mary of the return

• Next-year depreciation listing for the organization

• Indication on the return that the organization has changed its accounting period

• Preparer’s name in the “Preparer’s signature” line for preparer and client copies of 
a return that has been e-filed

Figure 15: PRNT screen options

The following items can be suppressed from the PRNT screen of a 990 return (see 
Figure 15):

• Commas (from the amounts printed on the forms)

• Columns B, C, and D of Form 990, Part IX, if the organization is not a 501(c)(3) 
or 501(c)(4) organization (Only Column A, Total expenses, would be generated 
for this section of Form 990.)

• Data for non-required fields on Form 990-T of gross receipts are $10,000 or less

Overriding Other Setup Options

Filing instructions (federal and state) and envelope coversheets (organization, IRS, 
and state) can be either forced or suppressed from the PRNT screen to override the 
global setting in Setup.

You can also enter the date to be printed on the return. In Setup > Options > 
Optional Items on Return, you can indicate if the return should have no date or if it 
should have the current system date. Use the PRNT screen to override the setup 
option choice for a return.

Turn Off Autobalance

Autobalance forces the balance sheet to balance for both the beginning- and end-of-
year amounts by adjusting net assets or fund balance.

The program makes the adjustments due to differences in the balance sheet. Incorrect 
data entry could cause these differences but they are usually the result of amounts 

NOTE
A default due date for filing is printed on all letters and filing instructions 
generated with a return. You can override the default date by entering 
an alternate due date in the Due date to print on letter and filing 
instructions field on the PRNT screen.
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being erroneously deleted or changed from the balance sheet screens. To reconcile the 
differences, it is best to compare the organization’s beginning and ending balance 
sheet amounts for the tax year.

To turn off this feature for a specific return, go to the PRNT screen and select Turn 
off autobalance.

Electronic Filing

An organization has the option to e-file Form 990, 990-EZ, 990-PF, 990-N, and 
related forms, schedules, and attachments. If the organization files at least 250 returns 
during the calendar year and has total assets of $10 million or more at the end of the 
tax year, it is required to e-file Form 990.

Steps for e-filing Form 990 are the same as for e-filing Form 1040. For detailed 
instructions on e-filing returns in Drake, see 2012 Drake Software User’s Manual.

IRS Error Reject Codes

If any of the following IRS error reject codes is generated when e-filing a 990 return, 
the preparer must contact the IRS for further information. The IRS e-Help Desk tele-
phone number is (866) 255-0654

R0000-905: Electronic Filing Identification Number (EFIN) in the Return Header 
must be listed in the e-file database and in accepted status.

F990-913: Tax-exempt status specified in Item I, must match data in the e-file data-
base.

R0000-922: Filer’s EIN and Name Control in the Return Header must match data in 
the e-file database, unless “Name Change” or “Name or Address Change” check box 
is marked, if applicable.

R0000-032: If “Amended Return” check box is not marked, then taxpayer TIN in the 
Return Header must not be the same as a TIN of a previously accepted electronic 
return for the return type and tax period indicated in the tax return.

NOTE Form 990-T cannot be e-filed.
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Appendix A: Adjustment Worksheet

The Adjustment Worksheet is updated each year to help you understand what happens 
in the return when certain data is changed through the use of adjustment fields. The 
following pages contain the 2012 Adjustments worksheet.

These worksheets are also available through the FAQ screen. To access them, open 
the FAQ screen, click the Screen Help button (or press CTRL+ALT+?) and click the 
links at the top of the window.
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Screen/Li

H - Hospita

6b

Form 990P
2

Form 990P

1a

Form 990T

40b

40c

42
Client Bill 

 Adjustment Location
     Adjustments Worksheet
ne Field Name Location of Information Being Adjusted

ls

Total Expense Adjusts calculated amount (see instructions).

F Part VIII - Officer Information
Total number of other employees paid over $50,000 Adjusts number flowing from the OFF screen

F Part XII - Qualifying Distributions
Adjustment of expenses if borrowed funds election 
exists Adjusts amount in Part 1, column (d), line 26

 Part IV - Tax and Payments

Other credits Adjusts amount flowing from screen 80, Common Credits 
section, 5735 and 8834.

General business credit Adjusts amount flowing from Form 3800, line 32

Other taxes Adjusts amount flowing from Form 8697
- Adjustments and Payments

Adjustments: Amount Enter an adjustment amount to appear on the client's bill with 
the corresponding description.

990
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Appendix B: Override Worksheet

The Override Worksheet is updated each year to help you understand what happens in 
the return when certain data is changed through the use of override fields. The follow-
ing pages contain the 2012 Override worksheet.

These worksheets are also available through the FAQ screen. To access them, open 
the FAQ screen, click the Screen Help button (or press CTRL+ALT+?) and click the 
links at the top of the window.
Tax Year 2011 B-1
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Form 9

     Overrides Worksheet
Override Location
n/Line Field Name Location of Information Being Overridden 

zation General Information

Preparer fee Overrides calculations made based on entries at Setup > 
Pricing.

Firm # Overrides the default selection (1)
Preparer # Overrides the default selection (1)
Data entry operator # Overrides login name.

ERO # Overrides the selection made from the ERO SSN Indicator drop 
list at Setup > Options, EF tab.

Name Overrides entry made on the OFF screen.
Street Overrides entry made on the OFF screen.
City Overrides entry made on the OFF screen.
State Overrides entry made on the OFF screen.
ZIP Code Overrides entry made on the OFF screen.
Telephone Overrides entry made on the OFF screen.

Depreciation Detail

Override regular depreciation,      Federal Overrides the system calculation for the "Current depr" column 
of the Depreciation Detail Listing.

 Affiliate Listing

 Listing Name Control Overrides Name Control determined by system using first four 
letters of affiliate name.

rt IX - Statement of Functional Expenses
2 Depreciation, depletion, and amortization Overrides amounts from Form 4562.
r 990) E-File Signature Authorization for Tax-Exempt forms

Signature Overrides information flowing from the OFF screen.
Title Overrides information flowing from the OFF screen.

Name Control Override Overrides first four letters of the name of the entity transmitted to 
the IRS when e-filing the return.

ptions

Print federal filing instructions Overrides option selected in Setup > Options, Optional 
Documents tab.

Print state filing instructions Overrides option selected in Setup > Options, Optional 
Documents tab.

Print taxpayer's envelope coversheet Overrides option selected in Setup > Options, Optional 
Documents tab, for the entity's envelope coversheet.

Print IRS envelope coversheet Overrides option selected in Setup > Options, Optional 
Documents tab, for the IRS coversheet.

Print state envelope coversheet Overrides option selected in Setup > Options, Optional 
Documents tab, for the state coversheet.

Date to print on returns
Overrides default date on the "Paid Preparer's" line at the bottom 
of the 990PF, page 13; 990EZ, page 4; the 990 letter; and the 
filing instructions.

Due date to print on letter and filing instructions Overrides the default Due Date that is printed on letters and filing 
instructions.

le D - Supplemental Financial Statements

e Part VI: Investments - Land, Buildings, and Equipment 
1e Other

Overrides amounts that flow from screen D1E (Schedule D, Part 
VI, line 1e).

le G - Information Regarding Fundraising or Gaming

4 Person who prepares the organization's gaming/special 
events books and records

Overrides name, address, city, state, and ZIP code from screen 
1 (General Information) or OFF (Officers, Directors, Employees) 
screen.

t I Revenues & Expenses
(a) Sale of assets not on line 10 Overrides the amount calculated on screen SCH5.
b Gross sales price - line 6a Overrides the amount calculated on screen SCH5.
90PF, Part II - Assets & Liabilities
(b) Other notes Overrides the amount calculated on screen SC14.

(b) Investments - land, buildings and other depr assets 
basis. Overrides any amounts flowing from screen SC53.

(b) Less accumulated depreciation Overrides any amounts flowing from screen SC53.
(c) Net investments Overrides any amounts flowing from screen SC53.
(b) Land, buildings, and equipment Overrides any amounts flowing from screen SC53.
(b) Less accumulated depreciation Overrides any amounts flowing from screen SC53.
(c) Net land, buildings, and equipment Overrides any amounts flowing from screen SC53.
90PF, Part IV - Capital Gains and Losses

990
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     Overrides Worksheet
Override Location

Form 9

Part VI
6

Part IX

Part XI
4
4

4

1

1

1

1

1

Part XI

2a

2c

3b

Form 9

990-T -

1

2
990-T -

4
Form 9

1

1
1118 F

3800 - 
1

1

n/Line Field Name Location of Information Being Overridden 
990

2 Capital gain net income or loss Overrides calculated gain amount from the sale of all assets.
3 Net short-term capital gain or loss Overrides calculated amount from Part IV, line 1.
90PF, Part V - Qualification Under Section 4940(e) for Reduced Tax

3
Number of years foundation has been in existence if 
less than 5

Overrides the calculated number of years from the entry on 
screen 1.

 - Excise Tax Based on Investment Income
c Tax paid with extension application Overrides amount entered on 8868 screen.

-B - Summary of Program-Related Investments
4 Cash deemed held for charitable activities Overrides the calculated amount.
II - Undistributed Income
a Applied to 2008 Reduces the 2008 undistributed income.
d Applied to 2009 distributable amount Reduces the 2009 distributable amount.

e Distributed out of corpus Overrides amount remaining after reducing 2009 distributable 
amount to zero.

5 Excess carryover applied to 2009 Overrides calculated amount

0a Excess 2005 Overrides the amount remaining on XIII line 3b after form 
calculations.

0b Excess 2006 Overrides the amount remaining on XIII line 3c after form 
calculations.

0c Excess 2007 Overrides the amount remaining on XIII line 3d after form 
calculations.

0d Excess 2008 Overrides the amount remaining on XIII line 3e after form 
calculations.

0e Excess 2009 Overrides the amount remaining on XIII line 4e after form 
calculations.

V - Private Operating Foundation

(a) Enter adjusted net income Pt 1 Overrides the lesser of the adjusted net income from Part I  or 
the minimum investment return from Part X for the year. 

(a) Qualifying distributions Overrides the value calculated in Part XII for line 4.

(a) Endowment alternative Overrides the value calculated using the amount from Part X, 
line 6.

90-T - Additional Information

B Exempt under section 501 Overrides exemption under section 501 (Tax-exempt status 
section) of screen 1 (General Information).

C Book value of all assets at end of year
Overrides amounts flowing from: Form 990, Part I, line 20 
(column b); Form 990EZ, Part II, line 25 (column b); Form 
990PF, page 1, item I.

J Books are in care of Overrides the information on the OFF screen or screen 1.
J Telephone number Overrides the information on the OFF screen or screen 1.
 Parts I & II - Income and Deductions

2 Other Income - Form 5471 Exchange Gain or Loss Overrides the amount flowing from Form 5471, Schedule I, line 
6.

1 Depreciation (Form 4562) Overrides amounts from Form 4562.
 Part IV - Tax and payments
0a Foreign tax credit Overrides the amount flowing from Form 1118.
90W - Estimated Tax on UBIT

0b Tax shown on current-year tax return
Overrides the smaller of the amounts flowing to this form from 
990T, page 2, line 43, and the calculated amount on Form 
990W, line 10a.

2 Required installment amounts Overrides the calculated amounts.
oreign Tax Credit Schedule B, Part II

1 Total foreign taxes paid or accrued Overrides calculated amount from Form 1118, Schedule B, Part 
I, column 2h.

2 Total taxes deemed paid Overrides calculated amount for Form 1118, Schedule B, Part I, 
column 3.

3 Reduction of taxes paid, accrued, or deemed paid Overrides amount carried from Schedule G.
5 Carryback or carryover of excess foreign taxes Overrides amount on Schedule K, line 3, column XIV.

7 Schedule J, Part I, line ii (if Sch J is required) Overrides amount on Schedule J, Part I, line 11, or Schedule A, 
column 13.

Parts I & II, Current Year Credits
3 25% of the excess, if any, of line 14 over $25,000 Overrides calculated amount.

7a If there has been an ownership change, acquisition, or 
reorganization (see IRS instructions) Overrides calculated amount.
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Override Location

Form 6
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1

1
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n/Line Field Name Location of Information Being Overridden 
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478

2 Alcohol 190 proof or greater and alcohol 190 proof or 
greater in fuel mixtures Overrides the default rates. Refer to form instructions.

3
Alcohol less than 190 proof but at least 150 proof and 
alcohol less than 190 proof but at least 150 proof in 
fuel mixtures

Overrides the default rates. Refer to form instructions.

4 Qualified cellulosic biofuel produced after 2008 that is 
alcohol Overrides the default rates. Refer to form instructions.

609 - Low-Income Housing Credit Allocation Certification

2 Schedule A - Annual Statement, Override of computed 
rate Overrides computed rate on Form 8609A, Part II, line 2.

Application for Employer Identification Number

County & state Overrides the county and state entered on screen 1 (General 
Information).

720 Certain Excise Taxes
, line 1 Taxes that apply to managers, self-dealers Overrides the amount being carried from Part II-A, column (l).

1 Schedule B Undistributed Income for years before 
2008

Overrides the amount carrying from Form 990-PF for 2009, Part 
XIII, line 6d.

2 Schedule B Undistributed Income for 2008 Overrides the amount that is carried automatically by the 
program from Form 990-PF, Part XIII, line 6e.

1 Schedule G - Excess of grassroots expenditures over 
grassroots nontaxable amount

Overrides the amount automatically carried by the program from 
the Schedule C., Forms 990 or 990-EZ, Part II-A, column (b), 
line 1(h).

2 Schedule G - Excess of lobbying expenditures over 
lobbying nontaxable amount

Overrides the amount automatically carried by the program from 
the Schedule C., Forms 990 or 990-EZ, Part II-A, column (b), 
line 1(i).

GR Tax or prorated amount Overrides amount of tax calculated for the event.
hange in Accounting Method

Tax year of change begins Overrides entry made on screen 1 (General Info).
Tax year of change ends Overrides entry made on screen 1 (General Info).
Contact person's telephone number Overrides entry made on screen 1 (General Info).

5 Parts II,IV Section - Net Section 481(a) adjustments for 
the year of change Overrides amount flowing from form 3115, section A, line 1h.

CHI Schedule I and Worksheets
1 Schedule I - Subpart F income Overrides calculations from worksheets A -D.
2 Schedule I - Earnings invested in US property Overrides calculations from worksheets A -D.

3 Previously excluded subpart F income withdrawn from 
qualified investments Overrides calculations from worksheets A -D.

4 Previously excluded export trade income withdrawn 
from investment in export trade assets Overrides calculations from worksheets A -D.

1 Worksheet A - Shareholder's pro rata share of line 30 Overrides calculated amount.

8b Worksheet A - Average exchange transaction rate Overrides rate entered on 5471 screen.

4 Worksheet B - U.S. shareholder's pro rata share of 
U.S. property held Overrides calculated amount.

3 Worksheet B - U.S. shareholder's pro rata share of line 
12 Overrides calculated amount.

7 Worksheet B - Year-end spot translation rate Overrides rate entered on 5471 screen.

5 Worksheet C - U.S. shareholder's pro rata share of line 
4 Overrides calculated amount.

b Worksheet C - Average exchange translation rate Overrides rate entered on 5471 screen.
2 Worksheet D - Pro rata share of line 1 Overrides calculated amount.
b Worksheet D - Average exchange translation rate Overrides rate entered on 5471 screen.
027 - Employer's Annual Information Return of Tip Income & Allocated Tips

7 Allocation of tips if using other than calendar year Overrides calculated amount for line 7 of form; place X in line 6 
to activate this override.

822 - Change of Address

4 Business name Overrides information entered on screen 1 (General 
Information).

b Employer ID number Overrides information entered on screen 1 (General 
Information).

6 New mailing address Overrides information entered on screen 1 (General 
Information).



Scree

     Overrides Worksheet
Override Location

Form 8

Form 8

Client 
n/Line Field Name Location of Information Being Overridden 
990

8 Daytime phone number Overrides information entered on screen 1 (General 
Information).

868 - Application for Extension of Time to File an Exempt Organization Return
Type of return to be filed Overrides the return type entered on screen 1.

Books in care of information Overrides the information flowing from screen 1 (General 
Information).

If group return, enter the four-digit Group Exemption 
Number (GEN)

Overrides the number flowing from screen 1 (General 
Information).

Extension of time until Overrides default date calculated by the system based on the 
entity's tax year.

925 - Report of Employer-Owned Life Insurance Contracts
Name of policyholder Overrides entries made on screen 1 (General Info).
ID number of policyholder Overrides entries made on screen 1 (General Info).

Bill - Adjustments and Payments
Billing option (overrides what is set up in options) Overrides select made in Setup > Options, Billing tab.
Custom paragraph option (overrides what is setup in 
options) Overrides select made in Setup > Options, Billing tab.

Date to be printed on bill Overrides the default date (the present date).
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Index

A
accomplishments, statement of 12
accounting method used 14
address

"books in care of" 14
foreign 10
of 527 organization 17
of affiliates 1, 10
of organization 9

adjustments to balance sheet 24
affiliates 1, 10
amending a return 20
attachments

from within data entry 7
general explanation 7
PDF 21–23

auto-balance 24

B
balance sheet

adjustments to 24
screens 12

blank forms 2
books in care of 14
business income returns (Form 990-T) 7

C
charity care for hospital 13
checklist of required schedules 15
commas, suppressing 24
compensation of officers, etc. 11, 14
contributors (Schedule B) 16
coversheets, options for 24
creating a new return 2
credit for excise taxes 7

D
date (to print on return) 24
depreciation listing 24
diagnostic summary, printing a 24

E
e-filing

and PIN signatures 19

Form 990-N (e-Postcard) 4
Form 990-T (not e-fileable) 8
PDF files 21–23
process 25

e-Postcards (Form 990-N) 3
error reject codes 25
exempt

achievement 13
purpose 12

expenses, statement of 12
extension, filing an 19

F
filing

an extension 19
instructions (options for) 24

final returns 2
financial statements

and reporting (Form 990, Part XI) 14
on Schedule D (Form 990) 17

fiscal year, indicating a 10
foreign addresses 10
Form 8868, Application for Extension 19
Form 990, Return of Org. Exempt from Income Tax 8–19
Form 990-EZ (short-form return) 4–??
Form 990-N (e-Postcard) 3
Form 990-PF (private foundations) 5–7
Form 990-T (business income returns) 7–8
form type, selecting a 10
functional expenses 12

G
governance, management, & disclosure 15
gross receipts 12

H
header information 2, 9
higher education, provision of 13

L
lobbying activities (Schedule C) 16
long-term care services, provision of 13
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N
Name Control field (screen 1) 1, 10
name of organization 9
narrative information, providing 18
natural disaster assistance 13
next-year depreciation listing 24

O
officer compensation 11, 14
order for completing

Form 990 8
Form 990-PF 6

organization contact information 9
other IRS filings and tax compliance 14
override

of setup options 24

P
partnerships, unrelated (Schedule R) 11
PDF files, e-filing 21–23
PIN signatures 19
political campaigns (Schedule C) 16
preparer signature 19
primary exempt purpose 12
prior-year returns, updating 2
private foundation return (Form 990-PF) 5–7
proxy tax liability 7
public status & support (Schedule A) 16

R
real estate investment trusts (REITs) 7
receipts, gross 12
regulated investment companies (RICs) 7
rehabilitation services 13
reject codes 25
related organizations (Schedule R) 11
required schedules, checklist of 15
returns

creating 2
updating from the prior year 2

revenue, statement of 11

S
SCH2 (attachment) screen 7
Schedule A (Public Status and Support) 16
Schedule B (Schedule of Contributors) 16
Schedule C (Political Campaign and Lobbying Activities)

16
Schedule D (Financial Statements) 17
Schedule L (Transactions with Interested Persons) 14

Schedule O (Supplemental Information) 18
Schedule R (Related Organizations and Unrelated Partner-

ship) 11
schedules, checklist of required 15
SERVICES pages 13
setup options, overriding 24
short-form returns (Form 990-EZ) 4–??
signature block 19
statement

see also financial statements
of functional expenses 12
of program service accomplishments 12
of revenue 11

summary
on Form 990, Part I 15
report printing 24

supplemental information (Schedule O) 18
suppressing commas 24

T
tax

compliance statements (Part V of Form 990) 14
excise, credit for 7
liability, reporting 7
year, specifying a 10

transactions (Schedule L) 14
type of form, selecting 10

U
unrelated business income, reporting 7
updating a prior-year return 2

V
volunteers 15
vi Tax Year 2012
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